Table of Contents

1. Introduction ............................................................................................................. 2
   1.1 Basic Approach of FRAME ................................................................. 2
   1.2 Information Required for Analysis .......................................................... 3
   1.3 Explanation of Analysis Results .............................................................. 5
2. Installation Guidelines ............................................................................................ 7
   2.1 Hardware Requirements for EWS ............................................................ 7
   2.2 Installing AutoCAD™ Version 10.0 .......................................................... 7
   2.3 Modifying AutoCAD Version 10.0 for Use with the EWS ...................... 7
   2.4 Installing the EWS ............................................................................... 9
3. Getting Started ....................................................................................................... 11
   3.1 Drawing Creation and Editing ................................................................. 12
   3.2 Data Input (through Dialog) ..................................................................... 14
   3.3 Reliability Analysis and Result Display .................................................. 14
   3.4 Other Utilities ...................................................................................... 15
   3.5 Important Remarks .............................................................................. 15
   3.6 Assumptions and Limitations .................................................................. 16
4 An Illustrative Example ........................................................................................... 18
   4.1 System Description ............................................................................... 18
   4.2 Reliability Analysis ............................................................................. 20
5. The EWS Commands ............................................................................................ 24
APPENDIX A Quick References for Building the EWS .............................................. 41
   A.1 Customizing AutoCAD ......................................................................... 42
      A.1.1 Menu File .................................................................................... 43
      A.1.2 Icons ......................................................................................... 44
      A.1.3 Blocks with Attributes .................................................................. 45
   A.2 AutoCAD External Commands ............................................................... 47
APPENDIX B ACAD.PGP File ............................................................................... 48
APPENDIX C Brief Description of the EWS Files and Programs ............................. 50
APPENDIX D EWS Software Architecture and Structure ..................................... 55
   D.1 EWS Software Architecture ............................................................... 56
   D.2 Software Internal Structure ................................................................. 57
This manual is intended to be a user's guide on how to set up and run FRAME. Its purpose is not to discuss in detail the methodology of this approach. For a more detailed discussion, the reader is referred to McGinnis, Beamon, and Fang [1992].

1. Introduction

FRAME is a software platform to model, analyze and appraise the reliability of monorail-based interbay material handling systems widely employed in semiconductor fabrication facilities. The purpose of FRAME is to facilitate the reliability assessment of such material handling systems and thus to enable the designer to incorporate reliability analysis into the design of semiconductor fabs.

The components of FRAME consist of a high performance personal computer, a printer, and a collections of commercial software to implementation the tools. The operating environment is based on AutoCAD™, a computer aided drafting package, which is used as the hub of modeling.

1.1 Basic Approach of FRAME

We assume a fixed rate at which requests for transport are generated. Each transport request corresponds to the movement of lot box by a car from one stocker to another. The entire transport rates can be described in a from/to matrix, which is referred to as transport requirement matrix. Accordingly, each entry in the matrix is a transport requirement.

Since cars may travel without a lot box (if none are awaiting transport where a delivery was just made), and failures may occur to unloaded cars, it is necessary to estimate the unloaded car travel. A trip is defined as the process of a car traveling (either loaded or unloaded) from one stocker to another. A dispatching rule is used to estimate the travel associated with unloaded cars, assuming a given transport requirement matrix. These unloaded travel rates are also described as a from/to matrix.

When a particular transport request (defined by an originating bay and a destination bay) is assigned to a particular car, the result is a transport task. Notice that a transport task will usually include some unloaded car travel to the originating bay.
The focus of this analysis approach is on both trips and transport tasks. Notice that a transport task failure is generally not the same as one component failure. Take the material control system (MCS) for example. One MCS failure is equivalent to \( N \) transport task failures where \( N \) is the average number of transport tasks in progress at any time. The core of FRAME is an analytical algorithm to estimate failed trips and failed transport tasks for one time period. Based on these estimates, the component types as well as the individual components that are most apt to cause transport task failures can be identified. We will explain the implications of the output of FRAME later in this chapter.

Premises of this approach are the following general assumptions which should be realistic for a practical material handling system in operation:

(a) All components are operating in the steady-state periods of their lifetime with regard to reliability. In other words, all components have constant failure rates or equivalently, mean time between failures (MTBF).

(b) All the components involved in each individual trip operate in series with regard to the trip. To put it another way, the failure of any one of these transactions will result in the failure of the entire trip.

(c) All the components in the material handling system operate independent of each other, including the transport cars. This is for the purpose of decoupling the evaluation of the frequency of failure incidents from the evaluation of the impact that failures have on production system performance.

Figure 1.1 briefly shows the structure of FRAME. In the next two sections we will discuss the user input and then the implications of analysis results.

1.2 Information Required for Analysis

As shown in Figure 1.1, the user input into FRAME includes 1) the material handling system layout and related parameters (transport requirement for one shift, transport car speed,
track segment speed factor, etc.), and 2) MTBFs of the components. For input of 1), the user needs to create the layout of the material handling system, and specify the necessary operating parameters. The data required in 2), however, are usually not readily available in reality, and a certain conversion process called normalization has to be carried out in order to get the desired data before the reliability analysis can be performed. In the following we illustrate the notions of conversion and normalization through examples. It is very important to emphasize here that we define mean time as the mean operating time as opposed to mean uptime in E10-90. Our MTBF is equivalent to mean cycles between failure (MCBF).

Let us assume that the transport car has a loaded traveling speed of $v_l$ feet per minute, and an unloaded traveling speed of $v_u$ feet per minute. We further assume that the total loaded and unloaded car travel per time period are $s_l$ and $s_u$ respectively. By observation we have found that the average car failures occurred per time period is $F_c$. Then the mean time between failure (MTBF) of the transport car can be calculated by

$$MTBF = \frac{(s_l/v_l + s_u/v_u)/60}{F_c} \text{ (hours)}$$

Procedures are similar for other modules. Assume the total number of transactions per time period performed by a module is C. From observation the module is found to have an average of $F_m$ failures per time period. Then the mean cycles (transactions) between failure is given by
\[ MCBF = \frac{C}{F_m} \]

Since for one transaction the module needs to operate \( t \) seconds, we get the mean time between failure (MTBF) of this module as follows:

\[ MTBF = MCBF \times \frac{t}{3600} = \frac{C \times t}{F_m \times 3600} \text{ (hours)} \]

Example Consider the cycle data for the AS/RS units collected over some time periods as follows:

<table>
<thead>
<tr>
<th>Num of cycles</th>
<th>Num of failures</th>
<th>Num of assists</th>
<th>MCBF</th>
<th>MCBF&amp;A</th>
</tr>
</thead>
<tbody>
<tr>
<td>322,810</td>
<td>42</td>
<td>459</td>
<td>7686</td>
<td>703</td>
</tr>
</tbody>
</table>

If we know the average operating time for one AS/RS cycle is 20 seconds, then the MTBF and MTBF&A can be readily computed from the above MCBF and MCBF&A respectively:

\[ MTBF = \frac{20}{3600} \times MCBF = 42.7 \text{ (hours)} \]

\[ MTBF \& A = \frac{20}{3600} \times MCBF \& A = 3.9 \text{ (hours)} \]

1.3 Explanation of Analysis Results

Analysis results generated by FRAME include the following:

- **Loaded and unloaded trip unavailability**

  These quantities measure the *inherent* reliability of the loaded and unloaded trips. By inherent we mean the measure is decoupled from the effect of different transport requirement. The trips with the highest unavailabilities should be avoided as much as possible since they tend to be unreliable during operation.

- **Expected number of trip failures**
These quantities measure the reliability of the trips under the given flow. They are the expected number of failures for each trip per unit time. The trips that have the highest numbers tend to have high trip unavailability and/or heavy lot flow.

• Expected number of transport task failures

These quantities measure the reliability of the material handling system under the given flow as well as the empty vehicle dispatching rule. Due to the fact these are a composite measures of system reliability, they tend to be of greater importance to system designer and operator. Also worth pointing out is that the sum of all these entries measures the overall reliability of the material handling system.

• Most critical components/modules

These are the components/modules that cause the most transport task failures in the system. These components either are inherently unreliable (low MTBF) or have heavy work loads or both. They provide insightful clues for system reliability enhancement.

• Contribution to transport task failures by each component type

This is a list of the amount of contribution to transport task failures in decreasing order by all component types. This information is useful in identifying which of the different component types are causing the most problems and thus also provide also sheds light in system reliability improvement.
2. Installation Guidelines

2.1 Hardware Requirements for EWS

The hardware requirements for the Engineering Work Station, EWS, are dictated by AutoCAD™ Version 10.0 that runs on a personal computer. If you already have (or are able to get) AutoCAD™ Version 10.0 on your computer, you may proceed to install the additional software that will help you analyze Automated Electrified Monorail Systems. Refer to the AutoCAD™ Installation and Performance Guide for the version number.

**If you do not have AutoCAD™ Version 10.0, STOP. You cannot install the EWS!**

2.2 Installing AutoCAD™ Version 10.0

Before installing the EWS software, please install AutoCAD™ Version 10.0 on a directory named by your preference. The installation procedure for AutoCAD™ Version 10.0 is described in the AutoCAD™ Installation and Performance Guide, and will not be repeated here.

NOTE: If you do not already have it, please put the following line in your AUTOEXEC.BAT file:

```
PROMPT $P$G
```

The operating system will display the current subdirectory name on the DOS prompt line.

2.3 Modifying AutoCAD™ Version 10.0 for Use with the EWS

Suppose AutoCAD™ Version 10.0 has been installed in a directory called ACAD. Once it has been installed on your system's hard disk, AutoCAD™ will need to be configured for your hardware system. The general configuration procedure is described in Appendix D of the AutoCAD™ Reference Guide. To perform the general configuration, do the following (What you need to type in is underlined):

1. Change the directory to ACAD by typing

   `C:\> CD\ACAD`

2. Invoke the AutoCAD™ program by typing
C:ACAD > ACAD
and you will be presented with the AutoCAD™ Main Menu.

3. Choose selection 5, "Configure AutoCAD", and you will then be presented with the current
configuration. Press the Enter key. Next, the Configuration Menu will be displayed. For the
general configuration, you need only to configure the video display, the digitizer, the plotter,
and the printer (selections 3, 4, 5, and 6 on the Configuration Menu).

4. Choose selection 3, "Configure video display". Note that AutoCAD™ can be configured in
either single-screen or dual screen modes. The dual screen mode requires an additional
monitor attached to your computer. The EWS will work with both single- and dual-screen
modes. If single-screen mode is desired, simply configure AutoCAD™ for the video board
contained in your computer. If dual-screen mode is desired, configure AutoCAD™ for the
video board which will drive the graphics screen. AutoCAD™ in dual-screen mode will make
the necessary adjustment. You will need to make a few changes to the EWS-specific file
START.BAT in order to use the EWS in dual-screen mode. Additional directions will be
provided once the EWS is installed.

NOTE: We have experienced some problems using the dual-screen mode with IBM PS/2
M80, for which we suggest the single-screen mode. Dual screen mode works better
with AT-style motherboards.

After identifying the video board in your computer, you will be presented with a number of
prompts. You should choose the default settings in response to all prompts except the
following:

Do you want a status line? <N> Y
Do you want a command prompt area? <Y> N
Do you want a screen menu area? <Y> N
Do you want dark vectors on a light background? <N> Y

5. Configure your digitizer (or mouse) following the directions on the configuration submenu.

6. If you have a printer and/or plotter that will work with AutoCAD™, configure your hardware
according to the directions on the configuration submenu. The EWS does not need a printer
nor a plotter to function, although both are desirable.

7. When finished with configuring your hardware, choose selection 8, "Configure operating
parameters", from the Configuration Menu. The Operating parameters menu will be
displayed.
8. Choose option 2, "Initial drawing setup", and specify the default prototype drawing by typing
   Enter name of default.....<->:PROTOTYP

9. Choose option 7, "AutoLISP feature", from the Operating parameters menu and make sure
   that AutoLISP is enabled by typing
   Do you want AutoLISP enabled? <N> Y

10. You are finished with the modification of AutoCAD™. Choose selection 0 for the next two
times to get out of the submenus. Accept the current configuration by pressing ENTER or by
typing
   Keep configuration changes? <Y> Y
   and, exit AutoCAD™ by selecting 0 from the main menu.

   If all is well up to this point, you are ready to install the EWS. If not, try the hardware
configuration again, and refer to AutoCAD™ documentation. Good luck!!

2.4 Installing the EWS

To install the EWS software, simply put the source disk into drive A or B and then type
"A:INSTALL" or "B:INSTALL" respectively under DOS prompt. Then follow the instructions
shown on the screen. When installation finished, it prompts "Installation Completed". It should
automatically create the directory you specified and another subdirectory called EXE under the
specified directory.

Suppose the directory you specified is called SEMATECH under the root directory.
Under directory SEMATECH, a batch file, START.BAT, comes initially configured for either the
single-screen or the dual-screen system. Without going through the installation procedure, you
can switch from single-screen to dual-screen mode and vice versa by simply modifying
START.BAT file. To switch to the single-screen mode, edit START.BAT with a text editor, and
put "REM * in front of "MODE MONO" command. For the dual-screen mode, simply remove
"REM * from the beginning of "MODE MONO".

NOTE: The AutoCAD™ related environment variables are identified in START.BAT by SET
xxx=xxx type statements. The settings in START.BAT are for typical systems. You may
get better performance from your hardware configuration if you have extra memory
(extended and expanded memory). Refer to AutoCAD™ Installation and Performance
Guide.

As with any software package, you should put the original diskettes away for safekeeping.
NOTE: For a brief description of the EWS files and programs, see Appendix C.

To test if the AutoCAD™ configuration will work with the EWS, type

C:\SEMATECH > \ACAD\ACAD

and invoke the AutoCAD™ program. From the main menu, choose selection 1, "Begin a NEW drawing", and supply any name for the drawing. If the hardware is configured correctly, the AutoCAD™ drawing screen will be displayed; a light gray background with a navy blue top line. If so, check if your mouse is operational by moving it around. If the crosshair is moving, you are most likely ready for a walkthrough. Exit from the drawing by typing QUIT (you may not actually see what you typed) and then Y. Then, exit from AutoCAD™ by choosing selection 0, "Exit AutoCAD", from the Main Menu. If all is well, congratulations! If not, try the hardware configuration again, and refer to AutoCAD™ documentation. Good luck!...
3. Getting Started

You are now ready for a hands-on session with the EWS. The demonstration project file, called DEMO_1, will be used for the walkthrough. Suppose the AEMS is installed under the directory named SEMATECH. In order to begin a work session, type

C: \> CD\SEMATECH

and then type

C:\SEMATECH> START

The copyright notice and the MHRC logo will be displayed. If you are using a dual-screen system, the PROFILE program will appear on the other display screen. The PROFILE program will prompt the user for the project file which will be active during the current work session. Pressing the F3 key will list the project filenames in the directory. Type

===\>DEMO_1

to view the project profile, DEMO_1. The PROFILE screen is a specialized spreadsheet where you may move between the fields by using the cursor keys on the keyboard. Any non-blank entry on the command line will replace the value of the current field. The purpose of this file is to insure consistency in the length and time units, the planning period (shift length) and the DOS filenames used for the neutral database of this project. You may change the name of the DOS files, although the extensions are standard and cannot be changed. Whenever necessary, supply the filenames without any extension. If you wish, you may experiment on this screen by moving to a field and entering a new value.

NOTE: For a new project, the user needs to press the F1 key to save the project profile. The user will be prompted for the limits of the new drawing (lower-left and upper-right coordinates), and the drawing screen will be set up with the specified absolute coordinates and some default drawing parameters. Then, when in AutoCAD™, a dialog box will be displayed that gives the user the opportunity to change the default drawing parameters.

In our case, since DEMO_1 project exists, press the F4 key to return to the main menu in profile. Press the F4 key once again to start project DEMO_1. The drawing file, DEMO_1.DWG, will be displayed on the graphics screen. This is the guidpath network for project DEMO_1.
3.1 Drawing Creation and Editing

The EWS's pull-down menus are located on the top line of the screen. Move the cross-hair to the top line. The menu selection names will appear. These pull-down menus contain several convenient features to help you draw and edit the guidepath network. All of the EWS commands are explained in greater detail in Chapter 5.

The File pull-down menu is used for file manipulation and printing activities. At any time during the session, you may use the Abandon command to leave the EWS without making any permanent changes to the drawing. The changes to the drawing are not made permanent until Save or Close is selected. The changes to the neutral database will not take effect until the Update Files command in menu Elements, Analysis or Dialog is selected.

The Layout menu is used for building the guidepath layout and specifying modules including turntables, turnouts, transfers, and stockers. Now, move the cursor to the top line to activate the menu line, highlight word Layout, and press and release the left button. The Layout main menu are displayed. They are Insert Blocks W/ Split and Insert Blocks W/O Split. The difference between them is if a split is performed after a block being inserted. The details is explained in chapter 5. Select Insert Blocks W/O Split, then the Layout submenu is displayed.

Move the cross-hair to Straight Segment command and click on the left mouse button. The menus on the top line of the screen will be replaced by the command prompt on the left side (the command prompts are always enclosed within "=>" and "<="), and the global coordinates of the cross-hair position on the right side. Go ahead and supply the endpoints of the segment which you wish to insert. After the end points of the segment are specified, a pop-up box will ask you to supply a segment name. Place the cross-hair inside the box and type in a segment name. Only the first 8 characters will be saved in the neutral database, although you may be able to see more characters on the screen. Pressing Enter will end the data entry into this field. Now, you must move the arrow in one of the small boxes; OK to accept the data in the box, Cancel to retain the old value. Then, the pop-up menu will go away, and the guidepath segment is drawn between the specified endpoints. This command will repeat automatically. If you wish, you may try to enter a few more straight segments. To get out of an automatically repeating command, press the right button on the mouse, or select Cancel command from the Edit menu, or enter a ^C (Ctrl key pressed simultaneously with letter C) from the keyboard.
Now, select **Curved Segment** from the **Layout** menu. Supply the beginning point of the curved segment with the cross-hair and enter the value of the radius from the keyboard. Then, an icon menu is presented for you to select the orientation of the curved segment. Move the arrow into the small box on the left of each icon to make the selection. A pop-up box will then appear which allows you to specify a segment name for the new segment. Then, the curved segment is drawn.

Now, move the cross-hair to the top line and select the **Sketch** menu. The **Sketch** menu contains utilities for drawing background and other ancillary items. The drawing elements created by the **Sketch** menu are for aesthetic purposes only. The user may wish to experiment with the drawing features in this menu. The text and the boxes on the drawing (all in black) are created by the commands in this menu.

The **Edit** menu enables the user to make modifications to the drawing as desired. Select the **Erase** command from the menu. Then, you may erase any object on the screen simply by placing the cursor box anywhere on the object and pressing the left mouse button. Go ahead and erase the straight and curved segments on the drawing. Remember to cancel the repeating command when finished. Similarly, you may erase several objects enclosed in a window using the **Erase Window** command. The operation of the other editing features are explained in Chapter 5.

The **Display** menu allows the user to zoom in, zoom out and pan around the drawing. Select the **Zoom In** command and take a closer look at the drawing details. Then, **Zoom Back** to your previous screen. The zoom functions will allow user to provide greater detail and accuracy when the guidepath network or module is being drawn. In addition, **Modify Layer** allows the user to select his or her favorite color or line type for each component of the drawing. Refer to Chapter 5 for more details.

The **Elements** menu allows the user to see the information associated with the various drawing elements and make changes. Select **Segment Info** (or **Module Info**) command from the menu, and click on a segment (or a module) with the cursor box. The pop-up menu will display the current attributes of the segment (or module). Each cell can be edited by placing the arrow inside the cell box and typing in the new value.
3.2 Data Input (through Dialog)

The **Dialog** menu contains the dialog routines. The dialog routines will allow user to view, scan, edit, and print information contained in the neutral database. Select the **Flow Requirements** command to view the current flow requirements for project DEMO_1. On a dual-screen system, the spreadsheet is displayed on the second screen. Use the cursor movement keys on the keyboard to move around the spreadsheet and change any flow value. The changes to the neutral database will not be made permanent unless the F1 key is pressed. Pressing the F4 key will return you back to the drawing. You may now select the other commands in this menu that operate basically the same way.

3.3 Reliability Analysis and Result Display

Now, pull down the **Analysis** menu and select the **Update Files** command. This command will activate a series of commands to extract needed information from the drawing, convert the extracted drawing information to its network representation, compute the shortest paths and update the neutral database. Any problems detected by the conversion program will be reported to the user. If there are any, correct the problems and update the files again. You may end this session at any time with the **Abandon** command in the **File** menu.

When the **Update Files** is successful, the **Reliability Analysis** command is made available; select this command. Then, the pie chart for *breakdown of failures by component type* is displayed. By pressing any key, another pie chart for *breakdown of task failures by requests* is displayed. Then, press 'q' to view the *trips with highest unavailability table*. The corresponding bar chart with top 10% unavailability is displayed by pressing **F1**. After viewing the bar chart, return the key control back to *loaded trip unavailability table* by pressing the space key. Similarly, the *unloaded trip unavailability table*, *expected number of loaded trip failures table*, *expected number of unloaded trip failures table*, and *expected number of transport task failures table* are displayed by pressing page-down key once, twice, three times, and four times respectively. You may press **F4** to quit the session or press page-up and page-down key to see those previous tables or charts again.

After quitting the result display session, it can be brought back again by selecting **Dialog**, then **Result Display**. The remaining operations are the same as previously mentioned.
3.4 Other Utilities

Finally, the Snap and the Utils menus provide useful tools for efficient operation. The Snap menu is used to change the snap and grid settings and activate the Osnap routines. The Utils menu provides the Shell utility which enable user to access the DOS commands while running the EWS. Select Shell and Return/Enter, then the DOS prompt will appear. Type "EXIT" to return back to AutoCAD when finishing DOS commands.

This concludes the walkthrough for the DEMO_1 project file. Feel free to explore the menus for additional features not explicitly mentioned in this chapter. Refer to Chapter 5 for the explanation of the EWS commands. Good luck!

3.5 Important Remarks

1. Use right-button of mouse or ^C to cancel the active command in AutoCAD

2. Always turn the Snap on while drawing the blocks within EWS.

3. Always draw the figure on the first quadrant (i.e. both X-coor. and Y-coor. are positive). Otherwise, the error message will occur when Updating Files.

4. Use F1 to toggle the key control between AutoCAD menu and AutoCAD command prompt if one monitor is used or between two monitors if dual monitors are used?

5. The following is the tip to draw a long segment. First, select Display menu, then Zoom In the starting point of the segment. Select Layout menu to insert segment. Suppose the Straight Segment command is chosen. Move the cursor to where the starting point is, then press the left button of mouse to input the starting point. Next, press F1 to toggle key control to AutoCAD command prompt. At this point, a message - "command: (setq QC (getpoint qa))" is displayed. Simply input the coordinate of the end point from keyboard by typing the X-coordinate, then a comma, followed by the Y-coordinate. For instance, suppose the coordinate of the end point is (100, 250). Simply type "100,250", then Return/Enter.
6. **Avoid drawing extremely short segments (straight or curved)**, since these segments are likely to be confused with the internal representations of modules which are also short segments. As a safety rule, a **segment length should always be at least 4 units**.

7. Each intersection point must have either a turnout or a turntable. Otherwise, **Update Files** can not successfully executed, and an error message will be reported.

8. Two (curved) segments are drawn one after another when **bi-directional (curved) segment** is selected. The first segment is drawn with the same starting and end points as you specified. While the second segment is drawn right on top of the first segment with reversed direction. If you draw the bi-directional segments from left to right, the bottom one is from left to right while the top one from right to left.

9. Each modules must have a unique 3-character ID. Otherwise, **Update Files** can not successfully executed, and an error message will be reported.

10. When the bi-directional (curved) segments are to be erased. Select the **Erase** command, point to the segments to be erased. Then click mouse button **twice**, since the two segments are overlapped. Only the top segment is erased if mouse button is clicked once.

11. When encountering the "Shell error: insufficient memory to execute the command", you can **not** continue to execute any command unless quitting the AutoCAD environment. Then reenter the AutoCAD to resume other executions of commands.

### 3.6 Assumptions and Limitations

1. Maximal number of stockers allowed is 60.

2. Curved or inclined segments can not be split. Thus, no module can be allowed on any middle point of the curved or inclined segments. However, it is allowed on both end points of the curved or inclined segments.

3. As mentioned in previous section (3.5), two segments with identical end points but in opposite directions will be inserted one after another when the **Bi-directional Segment** command
is selected. The bottom segment can not be selected so that it can not be edited unless the top segment is temporarily moved away.

4. All the bar charts display only up to 16 data items.

5. All the pie charts display only up to 16 data items.

6. Maximal MTBF that can be entered for each module is 9,999,999.99. Numbers greater than this should be entered as infinity (by inputting -1 from the keyboard).

7. Maximal Operation Time allowed for each module is 9,999.99.

8. Maximal Remark allowed for each module is 15 characters.

9. Maximal number of module types which can be entered from dialog program is 17.

10. The module type ID length is limited to two characters. The unique module ID length is limited to three characters.

11. Empty vehicle dispatching is based on factoring (or FCFS) rule.

12. Vehicles travel at constant speed on the same segment. Speed on different segments can be adjusted by multiplying the speed by the speed factor of that segment.

13. The MTBF of each module type is the mean operating time of that module type between two consecutive failures. This does not include the time periods in which the component is idle or shut down.
4 An Illustrative Example

In this chapter we use an example to illustrate how to utilize FRAME to perform reliability analysis. This example is included in the installation package and you can use it to test this software.

Legend: TT = Turntable; HT = Horizontal Transfer; AS/RS = Stocker

Figure 4.1 AMHS layout

4.1 System Description

System layout shown in Figure 4.1 consists of the following components:

- **ProgrammaTrak monorail track** There is approximately 1400 linear feet of track in a dual lane layout servicing all process aisles. Each track segment is unidirectional; the inside track runs clockwise whereas the outside track runs counterclockwise.
- **Horizontal transfers** There are 14 transfers off the track, each servicing one stocker.
- **Turntables** There are 4 dual lane turntables. They are installed at the four corners of the entire track to allow cars to switch track.

- **Transport car** The ProgrammaTrak transport cars with fixture carries a single lot box.

- **Automated work-in-process storage and retrieval units** There are 14 PRI WIP units (stockers) in the system. Each unit includes robotics, AS/RS unit control software, operator and host interfaces. The units are of varying capacity and configuration to meet specific process or layout requirements.

In addition to the above supplier components, the user has also developed a **Material Control System (MCS)** to manage the AMHS, along with an interface to the plant logistics control system.

The transport requirements matrix is shown in Table 4.1. This matrix is entered into FRAME by selecting command **Flow Requirements** in menu **Dialog**.

<table>
<thead>
<tr>
<th>Fr/To</th>
<th>8N</th>
<th>6N</th>
<th>7N</th>
<th>5N</th>
<th>6N</th>
<th>4N</th>
<th>5S</th>
<th>3N</th>
<th>4S</th>
<th>2N</th>
<th>2S</th>
<th>1N</th>
<th>1S</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>8N</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>8</td>
<td>0</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>10</td>
<td>6</td>
<td>0</td>
<td>36</td>
</tr>
<tr>
<td>6N</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>5</td>
<td>6</td>
<td>0</td>
<td>9</td>
<td>0</td>
<td>7</td>
<td>5</td>
<td>3</td>
<td>6</td>
<td>2</td>
<td>56</td>
</tr>
<tr>
<td>7S</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>4</td>
<td>0</td>
<td>12</td>
<td>4</td>
<td>0</td>
<td>8</td>
<td>7</td>
<td>5</td>
<td>4</td>
<td>0</td>
<td>44</td>
</tr>
<tr>
<td>7N</td>
<td>0</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>5</td>
<td>1</td>
<td>13</td>
<td>3</td>
<td>0</td>
<td>7</td>
<td>8</td>
<td>4</td>
<td>4</td>
<td>48</td>
</tr>
<tr>
<td>5N</td>
<td>4</td>
<td>13</td>
<td>3</td>
<td>5</td>
<td>0</td>
<td>11</td>
<td>17</td>
<td>0</td>
<td>15</td>
<td>8</td>
<td>8</td>
<td>8</td>
<td>4</td>
<td>96</td>
</tr>
<tr>
<td>6S</td>
<td>0</td>
<td>0</td>
<td>4</td>
<td>4</td>
<td>7</td>
<td>0</td>
<td>7</td>
<td>9</td>
<td>0</td>
<td>5</td>
<td>4</td>
<td>4</td>
<td>3</td>
<td>48</td>
</tr>
<tr>
<td>4N</td>
<td>8</td>
<td>7</td>
<td>13</td>
<td>11</td>
<td>19</td>
<td>9</td>
<td>0</td>
<td>17</td>
<td>0</td>
<td>13</td>
<td>7</td>
<td>17</td>
<td>11</td>
<td>132</td>
</tr>
<tr>
<td>5S</td>
<td>4</td>
<td>9</td>
<td>5</td>
<td>3</td>
<td>0</td>
<td>7</td>
<td>16</td>
<td>0</td>
<td>16</td>
<td>8</td>
<td>4</td>
<td>7</td>
<td>5</td>
<td>84</td>
</tr>
<tr>
<td>3N</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>3</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>8</td>
</tr>
<tr>
<td>4S</td>
<td>4</td>
<td>8</td>
<td>7</td>
<td>9</td>
<td>17</td>
<td>4</td>
<td>0</td>
<td>15</td>
<td>0</td>
<td>9</td>
<td>7</td>
<td>15</td>
<td>13</td>
<td>108</td>
</tr>
<tr>
<td>2N</td>
<td>8</td>
<td>0</td>
<td>5</td>
<td>7</td>
<td>12</td>
<td>0</td>
<td>19</td>
<td>8</td>
<td>4</td>
<td>13</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>88</td>
</tr>
<tr>
<td>2S</td>
<td>4</td>
<td>0</td>
<td>1</td>
<td>3</td>
<td>7</td>
<td>0</td>
<td>11</td>
<td>5</td>
<td>4</td>
<td>13</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>52</td>
</tr>
<tr>
<td>1N</td>
<td>4</td>
<td>7</td>
<td>0</td>
<td>4</td>
<td>11</td>
<td>5</td>
<td>17</td>
<td>5</td>
<td>0</td>
<td>11</td>
<td>8</td>
<td>4</td>
<td>0</td>
<td>76</td>
</tr>
<tr>
<td>1S</td>
<td>0</td>
<td>6</td>
<td>0</td>
<td>0</td>
<td>3</td>
<td>2</td>
<td>9</td>
<td>5</td>
<td>0</td>
<td>7</td>
<td>5</td>
<td>3</td>
<td>0</td>
<td>40</td>
</tr>
<tr>
<td>Total</td>
<td>36</td>
<td>57</td>
<td>41</td>
<td>51</td>
<td>96</td>
<td>47</td>
<td>133</td>
<td>84</td>
<td>8</td>
<td>103</td>
<td>88</td>
<td>56</td>
<td>76</td>
<td>40</td>
</tr>
</tbody>
</table>

The normalized MTBF of all component types is shown in Table 4.2. This data is entered into FRAME by selecting command **Module Type Info** in menu **Dialog**.
Table 4.2 MTBF of module types

<table>
<thead>
<tr>
<th>Component ID</th>
<th>MTBF(hr)</th>
<th>Oper. time(sec)</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>vh</td>
<td>814.0</td>
<td>travel time</td>
<td>transport car</td>
</tr>
<tr>
<td>ht</td>
<td>163.2</td>
<td>6</td>
<td>horizontal transfer</td>
</tr>
<tr>
<td>tt</td>
<td>427.9</td>
<td>10</td>
<td>turntable</td>
</tr>
<tr>
<td>sr</td>
<td>7.06</td>
<td>20</td>
<td>stocker</td>
</tr>
</tbody>
</table>

In addition to the above data, the following parameters concerning the operation of the system also need to be entered into FRAME:

- The transport car travels at the same constant speed of 70 ft/min whether loaded or empty.
- Horizontal transfers operate 6 seconds for one transaction (turning the car off or onto the track).
- Turntables operate for 10 seconds per transaction.
- AS/RS operate 20 seconds per storage or retrieval.

The transport car speed is entered by selection command Vehicle and MCS Specs in menu Dialog. The operating times of the other three module types are entered by selecting command Module Type Info.

4.2 Reliability Analysis

Now with the system layout created, various operating parameters and module type information entered into the computer, the reliability analysis is performed by simply selecting command Update Files and then selecting command Reliability Analysis in menu Analysis. The rest is automatically performed by the computer.

When the analysis is complete, the following information will be displayed on the screen:

1. Trip unavailability  The loaded trip unavailability table is something like Table 4.3, and the unloaded unavailability table looks like Table 4.4. If you press the key F1, a corresponding bar chart will display the 20% of the entries with the highest values. These are the most unreliable trips in the system.
Table 4.3 Loaded trip unavailability

<table>
<thead>
<tr>
<th>Fr/To</th>
<th>N8</th>
<th>N7</th>
<th>S7</th>
<th>N6</th>
<th>N5</th>
<th>S6</th>
<th>N4</th>
<th>S5</th>
<th>N3</th>
<th>S4</th>
<th>N2</th>
<th>S2</th>
<th>N1</th>
<th>S1</th>
</tr>
</thead>
<tbody>
<tr>
<td>N8</td>
<td>0.0000</td>
<td>0.0018</td>
<td>0.0017</td>
<td>0.0016</td>
<td>0.0017</td>
<td>0.0019</td>
<td>0.0017</td>
<td>0.0019</td>
<td>0.0017</td>
<td>0.0017</td>
<td>0.0017</td>
<td>0.0017</td>
<td>0.0017</td>
<td>0.0017</td>
</tr>
<tr>
<td>N7</td>
<td>0.0017</td>
<td>0.0000</td>
<td>0.0017</td>
<td>0.0016</td>
<td>0.0019</td>
<td>0.0017</td>
<td>0.0019</td>
<td>0.0017</td>
<td>0.0017</td>
<td>0.0017</td>
<td>0.0017</td>
<td>0.0017</td>
<td>0.0017</td>
<td>0.0017</td>
</tr>
<tr>
<td>S7</td>
<td>0.0017</td>
<td>0.0017</td>
<td>0.0000</td>
<td>0.0017</td>
<td>0.0017</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
</tr>
<tr>
<td>N6</td>
<td>0.0019</td>
<td>0.0020</td>
<td>0.0019</td>
<td>0.0000</td>
<td>0.0016</td>
<td>0.0019</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
</tr>
<tr>
<td>N5</td>
<td>0.0018</td>
<td>0.0000</td>
<td>0.0019</td>
<td>0.0000</td>
<td>0.0018</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
</tr>
<tr>
<td>S6</td>
<td>0.0018</td>
<td>0.0017</td>
<td>0.0018</td>
<td>0.0017</td>
<td>0.0018</td>
<td>0.0000</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
</tr>
<tr>
<td>N4</td>
<td>0.0018</td>
<td>0.0019</td>
<td>0.0019</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0017</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
</tr>
<tr>
<td>N3</td>
<td>0.0018</td>
<td>0.0017</td>
<td>0.0017</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0017</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
</tr>
<tr>
<td>N2</td>
<td>0.0018</td>
<td>0.0019</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
</tr>
<tr>
<td>N1</td>
<td>0.0018</td>
<td>0.0019</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0018</td>
</tr>
<tr>
<td>S1</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0019</td>
<td>0.0019</td>
<td>0.0018</td>
<td>0.0018</td>
<td>0.0017</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
<td>0.0016</td>
</tr>
</tbody>
</table>

Table 4.4 Unloaded trip unavailability

<table>
<thead>
<tr>
<th>Fr/To</th>
<th>N8</th>
<th>N7</th>
<th>S7</th>
<th>N6</th>
<th>N5</th>
<th>S6</th>
<th>N4</th>
<th>S5</th>
<th>N3</th>
<th>S4</th>
<th>N2</th>
<th>S2</th>
<th>N1</th>
<th>S1</th>
</tr>
</thead>
<tbody>
<tr>
<td>N8</td>
<td>0.0000</td>
<td>0.0002</td>
<td>0.0001</td>
<td>0.0001</td>
<td>0.0001</td>
<td>0.0003</td>
<td>0.0001</td>
<td>0.0001</td>
<td>0.0003</td>
<td>0.0001</td>
<td>0.0003</td>
<td>0.0001</td>
<td>0.0003</td>
<td>0.0003</td>
</tr>
<tr>
<td>N7</td>
<td>0.0001</td>
<td>0.0000</td>
<td>0.0001</td>
<td>0.0000</td>
<td>0.0001</td>
<td>0.0001</td>
<td>0.0001</td>
<td>0.0001</td>
<td>0.0001</td>
<td>0.0001</td>
<td>0.0001</td>
<td>0.0001</td>
<td>0.0001</td>
<td>0.0002</td>
</tr>
<tr>
<td>S7</td>
<td>0.0002</td>
<td>0.0001</td>
<td>0.0000</td>
<td>0.0001</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
</tr>
<tr>
<td>N6</td>
<td>0.0003</td>
<td>0.0004</td>
<td>0.0003</td>
<td>0.0000</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
</tr>
<tr>
<td>N5</td>
<td>0.0003</td>
<td>0.0004</td>
<td>0.0003</td>
<td>0.0002</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0003</td>
</tr>
<tr>
<td>S6</td>
<td>0.0002</td>
<td>0.0001</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
</tr>
<tr>
<td>N4</td>
<td>0.0002</td>
<td>0.0004</td>
<td>0.0003</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
</tr>
<tr>
<td>N3</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0003</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
</tr>
<tr>
<td>N2</td>
<td>0.0002</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
</tr>
<tr>
<td>N1</td>
<td>0.0002</td>
<td>0.0003</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
<td>0.0002</td>
</tr>
<tr>
<td>S1</td>
<td>0.0003</td>
<td>0.0002</td>
<td>0.0003</td>
<td>0.0003</td>
<td>0.0001</td>
<td>0.0003</td>
<td>0.0001</td>
<td>0.0003</td>
<td>0.0001</td>
<td>0.0003</td>
<td>0.0001</td>
<td>0.0003</td>
<td>0.0001</td>
<td>0.0003</td>
</tr>
</tbody>
</table>

2 Expected number of trip failures The expected number of loaded trip failure table is something like Table 4.5, and the expected number of unloaded trip failure table looks like Table 4.6. If you press the key F1, a corresponding bar chart will display the 20% of the entries in the table with the highest values. These are the trips that have the highest expected loaded or unloaded trip failures in the system.
Table 4.5. Loaded trip failures

<table>
<thead>
<tr>
<th>Fr/To</th>
<th>N8</th>
<th>N7</th>
<th>S7</th>
<th>N6</th>
<th>N5</th>
<th>S6</th>
<th>N5</th>
<th>S5</th>
<th>N3</th>
<th>S4</th>
<th>N2</th>
<th>S2</th>
<th>N1</th>
<th>S1</th>
</tr>
</thead>
<tbody>
<tr>
<td>N8</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.006</td>
<td>0.083</td>
<td>0.015</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.017</td>
<td>0.011</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>N7</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.004</td>
<td>0.008</td>
<td>0.002</td>
<td>0.019</td>
<td>0.021</td>
<td>0.005</td>
<td>0.000</td>
<td>0.012</td>
<td>0.013</td>
<td>0.007</td>
<td>0.006</td>
</tr>
<tr>
<td>N6</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.009</td>
<td>0.006</td>
<td>0.021</td>
<td>0.007</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>N5</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>N4</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>N3</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>N2</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
<tr>
<td>N1</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td></td>
</tr>
</tbody>
</table>

Table 4.6. Unloaded trip failures

<table>
<thead>
<tr>
<th>Fr/To</th>
<th>N8</th>
<th>N7</th>
<th>S7</th>
<th>N6</th>
<th>N5</th>
<th>S6</th>
<th>N5</th>
<th>S5</th>
<th>N3</th>
<th>S4</th>
<th>N2</th>
<th>S2</th>
<th>N1</th>
<th>S1</th>
</tr>
</thead>
<tbody>
<tr>
<td>N8</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>N7</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>N6</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>N5</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>N4</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>N3</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>N2</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>N1</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>S1</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
</tbody>
</table>

3 Expected number of transport task failures The expected number of transport task failure table is something like Table 4.7. If you press the key F1, a corresponding bar chart will display the 20% of the entries in the table with the highest values. These are the tasks that have the highest expected number failures under the current flow requirement and the empty transport car dispatching rule.
Table 4.7 Expected number of task failures

<table>
<thead>
<tr>
<th>Fr/To</th>
<th>N8</th>
<th>N7</th>
<th>S7</th>
<th>N6</th>
<th>N5</th>
<th>S6</th>
<th>N4</th>
<th>S5</th>
<th>N3</th>
<th>S4</th>
<th>N2</th>
<th>S2</th>
<th>N1</th>
<th>S1</th>
</tr>
</thead>
<tbody>
<tr>
<td>N8</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0074</td>
<td>0.0094</td>
<td>0.0169</td>
<td>0.0000</td>
<td>0.0063</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0194</td>
<td>0.0124</td>
<td>0.0000</td>
<td>0.0000</td>
</tr>
<tr>
<td>N7</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0056</td>
<td>0.0094</td>
<td>0.0213</td>
<td>0.0248</td>
<td>0.0063</td>
<td>0.0000</td>
<td>0.0147</td>
<td>0.0156</td>
<td>0.0083</td>
<td>0.0000</td>
<td>0.0000</td>
</tr>
<tr>
<td>S7</td>
<td>0.0000</td>
<td>0.0107</td>
<td>0.0062</td>
<td>0.0000</td>
<td>0.0079</td>
<td>0.0000</td>
<td>0.0240</td>
<td>0.0081</td>
<td>0.0000</td>
<td>0.0162</td>
<td>0.0143</td>
<td>0.0100</td>
<td>0.0082</td>
<td>0.0000</td>
</tr>
<tr>
<td>N6</td>
<td>0.0080</td>
<td>0.0106</td>
<td>0.0061</td>
<td>0.0257</td>
<td>0.0000</td>
<td>0.0220</td>
<td>0.0322</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0295</td>
<td>0.0146</td>
<td>0.0156</td>
<td>0.0146</td>
<td>0.0077</td>
</tr>
<tr>
<td>S6</td>
<td>0.0000</td>
<td>0.0076</td>
<td>0.0079</td>
<td>0.0000</td>
<td>0.0135</td>
<td>0.0000</td>
<td>0.0137</td>
<td>0.0178</td>
<td>0.0000</td>
<td>0.0098</td>
<td>0.0080</td>
<td>0.0078</td>
<td>0.0060</td>
<td>0.0019</td>
</tr>
<tr>
<td>N4</td>
<td>0.0158</td>
<td>0.0229</td>
<td>0.0261</td>
<td>0.0136</td>
<td>0.0372</td>
<td>0.0177</td>
<td>0.0000</td>
<td>0.0330</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0232</td>
<td>0.0134</td>
<td>0.0305</td>
<td>0.0208</td>
</tr>
<tr>
<td>S4</td>
<td>0.0073</td>
<td>0.0190</td>
<td>0.0173</td>
<td>0.0091</td>
<td>0.0124</td>
<td>0.0314</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0317</td>
<td>0.0160</td>
<td>0.0078</td>
<td>0.0141</td>
<td>0.0097</td>
<td></td>
</tr>
<tr>
<td>N3</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0059</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0019</td>
<td>0.0019</td>
<td>0.0000</td>
<td>0.0000</td>
</tr>
<tr>
<td>S3</td>
<td>0.0079</td>
<td>0.0173</td>
<td>0.0141</td>
<td>0.0155</td>
<td>0.0334</td>
<td>0.0072</td>
<td>0.0000</td>
<td>0.0267</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0182</td>
<td>0.0138</td>
<td>0.0305</td>
<td>0.0254</td>
</tr>
<tr>
<td>N2</td>
<td>0.0156</td>
<td>0.0144</td>
<td>0.0099</td>
<td>0.0000</td>
<td>0.0232</td>
<td>0.0000</td>
<td>0.0372</td>
<td>0.0154</td>
<td>0.0076</td>
<td>0.0248</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0159</td>
<td>0.0056</td>
</tr>
<tr>
<td>S2</td>
<td>0.0080</td>
<td>0.0078</td>
<td>0.0020</td>
<td>0.0000</td>
<td>0.0139</td>
<td>0.0000</td>
<td>0.0221</td>
<td>0.0090</td>
<td>0.0081</td>
<td>0.0234</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0062</td>
<td>0.0020</td>
</tr>
<tr>
<td>N1</td>
<td>0.0077</td>
<td>0.0082</td>
<td>0.0000</td>
<td>0.0133</td>
<td>0.0211</td>
<td>0.0096</td>
<td>0.0329</td>
<td>0.0096</td>
<td>0.0000</td>
<td>0.0208</td>
<td>0.0158</td>
<td>0.0075</td>
<td>0.0000</td>
<td>0.0000</td>
</tr>
<tr>
<td>S1</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0000</td>
<td>0.0119</td>
<td>0.0060</td>
<td>0.0037</td>
<td>0.0182</td>
<td>0.0091</td>
<td>0.0000</td>
<td>0.0127</td>
<td>0.0103</td>
<td>0.0075</td>
<td>0.0000</td>
<td>0.0000</td>
</tr>
</tbody>
</table>

4 Breakdown of task failures by component types This pie chart on the screen displays the expected task failure numbers as well as their percentage attributed to different component types. It gives an idea of which component types are causing the most reliability problems within the system.

5 The Most critical components FRAME will automatically highlight in the system layout drawing those individual modules (as opposed to module types) that have the highest expected number of task failures. These are the most critical components that should be aimed at while trying to improve the system reliability.
5. The EWS Commands

The individual commands are grouped under the menu names at which they belong. The menu names are listed in the same order as they appear on the screen.

NOTE: Several menu commands repeat automatically. In order to terminate a repeating command, the user may press the right button on the mouse, or select the Cancel command from the Edit menu, or enter a ^C (Ctrl key pressed simultaneously with letter C) from the keyboard.
FILE

Save saves the currently active drawing file to disk.

Save As saves the currently active drawing file under a new name.

Close ends the current AutoCAD™ editing session. The current drawing file is saved to disk, and the user is returned to DOS.

Abandon abandons all modifications made to the drawing during the current editing session. The user is returned to DOS.

Open abandons all modifications made to the drawing during the current editing session and the user is allowed to load another project file.

Plot plots the currently active drawing. Additional information must be supplied by the user to specify the plot size. The current drawing file remains active.

Print prints the currently active drawing. Additional information must be supplied by the user to specify the plot size. The current drawing file remains active.
Insert (With Split):

**Straight Segment** inserts a straight guidepath segment into the layout. The user is prompted for the two endpoints of the straight segment. The endpoints are checked to see whether they lie along the interior of previously inserted guidepath segments. If so, that guidepath segment is split before the new segment is inserted.

**Bidirectional Segment** insert two straight guidepath segments in opposite direction. The user is prompted for the two endpoints of a straight segment. Its operation and general attributes are same as above.

**Reverse of Segment** Asks the user to point to a straight segment and inserts another straight guidepath segment in opposite direction. Its operation and general attributes are same as a straight segment. This selection can be used to make an existing segment bi-directional.

**Curved Segment** inserts a curved guidepath segment into the layout. The user is prompted for the beginning point of the curved segment, the curve radius, and the curve orientation (the latter is chosen from an icon menu). This command will always draw the curve as a quarter circle. The two endpoints of the curve are checked to see whether they lie along the interior of previously inserted guidepath segments. If so, the guidepath segment(s) will be split before the new curved segment is inserted.

**Turntable** inserts a turntable into the layout. The user is prompted for the location of the turntable. Then the user is asked to enter the attributes associated with the turntable just being inserted. If the insertion point falls on an existing segment, the segment is split into two segments.

**Turnout** inserts a turnout switch into the layout. The user is prompted for the location of the turnout. Then the user is asked to enter the attributes associated with the turnout just
being inserted. If the insertion point falls on an existing segment, the segment is split into two segments.

**Stocker** inserts a stocker and a transfer into the layout simultaneously. The user is prompted for the location of the transfer (with stocker). Then the user is asked to enter the attributes associated with the stocker and transfer just being inserted. If the insertion point falls on an existing segment, the segment is split into two segments.

**Transfer** inserts a horizontal transfer into the layout. The user is prompted for the location of the horizontal transfer. Then the user is asked to enter the attributes associated with the horizontal transfer just being inserted. If the insertion point falls on an existing segment, the segment is split into two segments.

**Vertical Transfer** inserts a vertical transfer into the layout. The user is prompted for the location of the vertical transfer. Then the user is asked to enter the attributes associated with the vertical transfer just being inserted. If the insertion point falls on an existing segment, the segment is split into two segments.

**Split Straight Segment** splits a straight guidepath segment into two separate segments. The user is prompted for the position at which the split will be made.

**Join Two Segments** combines two contiguous straight guidepath segments into a single segment. The user is prompted for the position at which the two segments are to be joined.
LAYOUT

Insert (Without Split):

Straight Segment inserts a straight guidepath segment into the layout. The user is prompted for the two endpoints of the straight segment. However, a split will not occur.

Bidirectional Segment inserts two straight guidepath segments in opposite direction. The user is prompted for the two endpoints of a straight segment. However, a split will not occur.

Reverse of Segment asks the user to point to a straight segment and inserts another straight guidepath segment in opposite direction. However, a split will not occur. This selection can be used to make an existing segment bi-directional.

Curved Segment inserts a curved guidepath segment into the layout. The user is prompted for the beginning point of the curved segment, the curve radius, and the curve orientation (the latter is chosen from an icon menu). This command will always draw the curve as a quarter circle. However, a split will not occur.

Turntable inserts a turntable into the layout. The user is prompted for the location of the turntable. Then the user is asked to enter the attributes associated with the turntable just being inserted. However, a split will not occur.

Turnout inserts a turnout switch into the layout. The user is prompted for the location of the turnout. Then the user is asked to enter the attributes associated with the turnout just being inserted. However, a split will not occur.

Stocker inserts a stocker and a transfer into the layout simultaneously. The user is prompted for the location of the transfer (with stocker). Then the user is asked to enter the attributes associated with the stocker and transfer just being inserted. However, a split will not occur.
Transfer inserts a horizontal transfer into the layout. The user is prompted for the location of the horizontal transfer. Then the user is asked to enter the attributes associated with the horizontal transfer just being inserted. However, a split will not occur.

Vertical Transfer inserts a vertical transfer into the layout. The user is prompted for the location of the vertical transfer. Then the user is asked to enter the attributes associated with the vertical transfer just being inserted. However, a split will not occur.

Split Straight Segment splits a straight guidepath segment into two separate segments. The user is prompted for the position at which the split will be made.

Join Two Segments combines two contiguous straight guidepath segments into a single segment. The user is prompted for the position at which the two segments are to be joined.
**SKETCH**

---

**Line** draws a single straight line. The user is prompted for the two endpoints of the line.

**Circle** draws a circle. The user is prompted for the center and the radius of the circle.

**Arc** draws a portion of a circle. The user is prompted for the center of the circle, one endpoint of the arc, and the angle which is swept out by the arc.

**Box** draws a rectangular box. The user is prompted for opposite corners of the box.

**Text** allows the user to place text on the drawing. The user is prompted for the starting point of the text, the text height, and the text.
EDIT

Erase W/ Join erases any visible element on the drawing file. The user is prompted to select the object to be erased. If there are two segments, one starting and another ending, at the insertion point of the object, these two segments will be joined into one segment. Note that it is not recommended to erase a module by this command when it is located at the intersection where segments with different types (for instance, one uni-directional, and another bi-directional) are joined. In this case, use Erase W/O Join to erase the module.

Erase W/O Join erases any visible element on the drawing file. The user is prompted to select the object to be erased. However, no "Join" operation is performed after the module is erased.

Erase Window erases all elements which are entirely contained within a specified window. The user is prompted to enter the two opposite corners of the window.

UnErase undoes the last erase command.

Move W/ Join & Split moves a selected object from one point to another. The user is prompted for the object to be moved, the point that it will be moved from, and the point it will be moved to. If the moved object is a straight segment, this command also performs the "Join" and "Split" operation at the two endpoints of the segment. However, this command is not recommended for the beginners.

Move W/O Join & Split moves a selected object from one point to another. The user is prompted for the object to be moved, the point that it will be moved from, and the point it will be moved to.

Move Window moves all objects which are entirely contained within a specified window. The user is prompted for the opposite corners of the window, the point from which the collection of objects will be moved, and the point to which they will be moved to.
Copy makes a copy of a selected object. The user is prompted for the object to be copied, the location of a reference point for the original, and the location of the corresponding point for the copy.

Copy Window copies all objects which are entirely contained within a specified window. The user is prompted for opposite corners of the window, the location of a reference point for the originals, and the location of the corresponding point for the copies.

Rotate rotates a selected object. The user is prompted for the object to be rotated, the pivot point, and the angle of rotation. The angle of rotation (in degrees) increases counterclockwise. Negative angles are permissible.

Rotate Window rotates a group of objects contained entirely within a specified window. The user is prompted for opposite corners of the window, the pivot point about which the group of items will be rotated, and the angle of rotation. The angle of rotation (in degrees) increases counterclockwise. Negative angles are permissible.

Reverse Straight Segment reverses the direction of travel along a straight segment. The user is prompted for the segment to be reversed. This command is for uni-directional straight segments only.

Reverse Curved Segment reverses the direction of travel along a curved segment. The user is prompted for the curved segment to be reversed. This command is for uni-directional curved segments only.

Stretch Segment increases the length of a guidepath segment. The tail endpoint of the segment remains at the same location, while the segment is "stretched". The attributes associated with the segment (i.e., the segment label) are not affected. This command is for uni-directional straight or curved segments only.

Shrink Segment decreases the length of a guidepath segment. The tail endpoint of the segment remains at the same location, while the segment is "shrunk". The attributes associated with the segment (i.e., the segment label) are not affected. This command is for uni-directional straight or curved segments only.
Rescale Modules changes the size of all the modules including turntables, turnouts, stockers, horizontal transfers, and vertical transfers. The user is prompted for the scale factor. The modules will be drawn in size equal to the scale factor times their current size. The scale factor may be smaller than 1, but not zero.

Rescale Layout rescales the entire layout drawing. The scale factor may be smaller than 1, but not zero. For example, a scale factor of 2 means that all drawing element dimensions will be multiplied by 2.

Undo undoes the results of the previously selected menu command. Users may need to click Undo several times to finally undo the commands since each menu command performs a series of AutoCAD commands.

Redo restores the previously undone command.

Cancel cancels the currently active command.
DISPLAY

Zoom In  zooms in on the portion of the drawing contained within a specified window. The user is prompted for opposite corners of the zoom window.

Zoom Back returns to the view which was displayed prior to the last Zoom or Pan command.

Zoom All displays the entire limits of the drawing.

Zoom To Fit displays the minimum area large enough to contain all elements in the drawing.

Zoom Dynamic displays a dynamic box - whose size and location can be adjusted - representing the area to zoom in.

Pan moves the current display on the virtual screen.

Redraw redraws the elements on the screen deleting all blips and regenerates the edited portions of the drawing elements. We suggest generous use of this command during editing sessions.

Turn Hilight ON highlights all critical modules. Note that this command doesn't work until Reliability Analysis is done.

Turn Hilight OFF returns all previously highlighted modules to their original color.

Hilight Display % allows the users to specify the percentage of critical modules to be displayed. For example, select this command and type '0.2' or '.2' then 'Enter' to set display percentage to 20%. Note that the numbers typed are not shown on the screen. The default is set to 0.1, i.e. 10%.

Turn Arrowheads ON makes all the arrowheads the same size. Draws the arrowheads of certain size on different layer (named "Arrowheads") to cover the original arrowheads of different sizes so that the arrowheads are more visible.
Rescale Arrowheads changes the size of the arrowheads. It can only change the size of the arrowheads which are "Turned On" (i.e. on layer "Arrowheads").

Turn Arrowheads OFF removes from screen the arrowheads which are added by "Turn Arrowheads On".

Display Ctrl. Pt. IDs displays all the control point IDs on the screen.

Remove Ctrl. Pt. IDs erases all the control point IDs from the screen.

Modify Layer activates a dialog box which provides a variety of functions relating to layers: turning layers on and off, changing the active layer, changing the color or line type of layers, creating new layers, etc.

NOTE: The components and the layers on which they are drawn are listed below.

<table>
<thead>
<tr>
<th>Component</th>
<th>Layer Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>all the modules (turntables, ..etc.)</td>
<td>modules</td>
</tr>
<tr>
<td>all uni-directional segments</td>
<td>zero (o)</td>
</tr>
<tr>
<td>all bi-directional segments</td>
<td>twoway</td>
</tr>
<tr>
<td>all backgrounds (text, line, ...etc.)</td>
<td>machines</td>
</tr>
<tr>
<td>arrow heads</td>
<td>arrowheads</td>
</tr>
<tr>
<td>control points</td>
<td>controlpoints</td>
</tr>
</tbody>
</table>

** Line types can be modified by editing the file: ACAD.LIN under the directory where ACAD™ is stored.
ELEMENTS

Update Files updates the neutral data files. This command must be chosen after changes are made to the drawing in order to insure that the analysis routines use the latest information. Before the data files are updated, the other selections available from this menu are "grayed out" and cannot be selected.

Segment Info command activates a dialog box which allows the user to edit the information associated with the selected guidepath segment.

Module Info command activates a dialog box which allows the user to edit the information associated with the selected module.

Segment List command runs an external program which lists all segment-related data since the last "Update Files" command. This command can be used to view segment information sorted in various ways and also to obtain a hardcopy listing.

Module List command runs an external program which lists all module-related data since the last "Update Files" command. This command can be used to view module information sorted in various ways and also to obtain a hardcopy listing.
ANALYSIS

Update Files updates the neutral data files. This command must be chosen after changes are made to the drawing in order to insure that the analysis routines use the latest information. Before the data files are updated, the other selections available from this menu are "grayed out" and cannot be selected.

Reliability Analysis command executes the reliability model and displays the results on the screen. The results include: (i) breakdown of failures by component type; (ii) breakdown of task failures by requests; (iii) loaded/unloaded trip unavailability; (iv) expected number of loaded/unloaded trip failures; (v) expected number of transport task failures.
DIALOG

Update Files updates the neutral data files. This command must be chosen after changes are made to the drawing in order to insure that the analysis routines use the latest information. Before the data files are updated, the other selections available from this menu are "grayed out" and cannot be selected.

Flow Requirements allows the user to view or update the flow rate data (usually called the from-to matrix). This matrix defines the flows between each pair of (P, D) stations associated with two stockers. Users may also specify (or edit) the flow requirements by moving the cursor to the desired location within the matrix and typing the value on the command line. The active function keys are displayed at the bottom line.

Module Type Info allows the user to specify the module information including module type ID, Mean Time Between Failure (MTBF), operation time, and remarks. The MTBF can be infinite by inputting "-1".

Vehicle & MCS Specs allows the user to view and edit the specifications for both the vehicles and material control systems (MCS). These include vehicle top speed, vehicle MTBF, vehicle loaded speed adjustment, and MCS MTBF. The MTBF can be infinite by inputting "0".

Result Display command is to display the computational result of the reliability model as those shown after the "Reliability Analysis" is done.

Profile allows the user to view the project profile for the currently active project. The user can move between the data fields using the cursor movement keys on the keyboard. The information on each cell can be changed by entering the value at the prompt line.
SNAP

Snap/Grid command activates a dialog box which allows the user to alter the snap and grid settings. The snap spacing sets the minimum pointer resolution. When the snap mode is turned on, an invisible snap grid is activated, and only the points which are on the grid can be selected. The X Base and Y Base settings specify the origin of the snap grid. For example, if the snap spacing is set to 1.0000 unit and the X and Y Bases are set to 0.0000, only integer positions will be allowed when snap mode is on. A visible reference grid and axis markings can be used as drawing aids, and the appropriate settings for these items are also specified in this dialog box.

Aperture sets the sensitivity with which objects are selected. The user is prompted to enter a target height, in pixels, which specifies how far away from the cross-hairs an object can be located and still be selected.
UTILS

Shell utility allows the user to run DOS commands and come back to EWS without effecting.
APPENDIX A  Quick References for Building the EWS
A.1. Customizing AutoCAD

You can extend AutoCAD's capabilities and customize it for your application by designing your own menus and libraries to complement those supplied with the program. The file used to create custom AutoCAD menus is a text file with the type *.mnu* containing AutoCAD command strings. Sections of the file can be associated with different menu devices, such as the screen and tablet menus. To construct a custom menu, use a text editor (such as Brief) or a word processor (such as Word) in "programmer" mode; you don't want the editor to put in extra characters, indentation, etc.

Each menu item may consist of a command, a parameter, or a sequence of commands and parameters. Normally, each menu item resides on one line of the file.

**NOTE:** If you intend to supply command parameters as part of a menu item, you must be very familiar with the sequence in which that command expects its parameters. Every character in a menu item is significant, even the blank spaces. From time to time as AutoCAD is revised and enhanced, the sequence of prompts for various commands (and sometimes even the command names) may change; your custom menus may require minor changes when you upgrade to a new version of AutoCAD.
A.1.1. Menu File

Section Labels

A menu file can be logically broken into several sections, identified by section labels. Each section belongs to a different menu device and contains command strings targeted for that device. The section labels are:

***SCREEN - Screen menu area
***POPn - Pull-down menu area (where n is a number from 1 to 10)
***ICON - Icon menu area
***BUTTONS - Pointer device button menu
***TABLETn - Tablet menu area (where n is a number from 1 to 4)
***AUX1 - Auxiliary "function box" button menu

These labels specify that subsequent menu items, up to the next section label or the end of file, belong to a specific menu device.

Submenu Definition

A submenu label marks the start of a submenu. It has the format:

**name

The "name" is a string up to 31 characters long containing letters, digits, and the special characters "$", "-" and ".". The submenu label must reside on a menu file line by itself and must not contain embedded blanks. All submenu names within a file must be unique. Menu items that immediately follow a submenu label, up to the next submenu label, section label, or end of file, belong to that submenu label.

Submenu Reference

You use the following construct within a menu item to activate or deactivate a submenu:

$section=submenu

where:

section Specifies the menu section. Valid names are:

S (for the SCREEN menu)
P1 - P10 (for POP menus 1 through 10)
I (for the ICON menu)
B (for the BUTTONS menu)
T1 - T4 (for TABLET menus 1 through 4)
A1 (for the AUX1 menu)

**Submenu** Specifies which submenu to activate. The name must be either one of the submenu labels (without the "••••") in the currently loaded menu file or a menu section names as defined above.

Examples:
$S=PARTS
$P7=P7B

**NOTE:** You can use the special command "$Pn=" (from within any menu item) to force the menu currently assigned to area "POPn" to appear (pull down) on the screen.

A.1.2. Icons

In AutoCAD, a slide is a file containing a "snapshot" of the display on the graphics monitor. Usually a slide can be created to represent an icon for special application. You can use ordinary AutoCAD commands to obtain the desired view on the monitor and then make a slide of that display. The MSLIDE command is used to make a slide of current viewport. First, create the display you wish to save, then enter:

```
Command: MSLIDE  Slide file <default>: (name)
```

The current drawing name is offered as a default. Press RETURN if you wish to use it. A file type of ".sid" is appended to the name you apply; do not include a file type in your response.

You can construct *slide libraries* from ".sid" files by using the SLIDELIB utility program supplied on the AutoCAD "support" disk. To construct a slide library, enter command:

```
C:\ACAD > slidelib  library [<slide-list]`
```

at the operating system command prompt. SLIDELIB reads a list of slide file names from standard input. This is normally supplied by redirecting a list of files (one per line in another file prepared using a text editor or a user-supplied utility program) to standard input. The resulting composite library is written to the file specified by "library", with file type ".sib". The files named in "slide-list" need not have file types specified. However, if a file type is specified it must be ".sld". For example, in AGVS EWS we've created a file named "slides.lst" listing slide names "ccwise",
"clockwise", "exit", "cancel", ..., and "wsstor", we could assemble slides into a slide library named "slides.slb" by entering:

```
C:\SEMATECH > \acad\slidelib slides <slides.lst
```

or

```
C:\SEMATECH > \acad\slidelib slides.slb <slides.lst
```

The SLIDELIB program makes no provision for updating a slide library once it is created. If we wish to add or delete a slide, just update the "slide-list" file and remake the library with SLIDELIB. Note that all the original slides must be present in order to do this.

A.1.3. Blocks with Attributes

A Block is a set of entities grouped together into a compound object. Once so grouped, the entities are given a Block Name. You can use this name to insert that group of entities into your drawing wherever you like. A block is treated as a single object by AutoCAD. For example, in EWS we define as blocks the objects including (curved) segments, turntables, turnouts, transfers, and stockers.

Attributes are special AutoCAD drawing entities that contain text. You can use them to label Blocks in the drawing, then later collect them into a disk file for processing by the other applications. In EWS, each block is associated with several attributes. For example, the stocker-block has four attributes including: (i) stocker ID; (ii) transfer ID; (iii) stocker type; and (iv) transfer type.

To use an Attribute, you must first create an Attribute Definition using the ATTDEF command. An Attribute Definition is an AutoCAD drawing entity that describes the characteristics of the Attribute. It is displayed on the screen as a text string, called the Attribute tag. After you create the Attribute Definition, you can specify it as one of the entities to be included in a Block Definition. Thereafter, whenever you INSERT the Block, AutoCAD can prompt you for the value of the attribute, which may be any text string. Thus, each occurrence of the Block can have a different value for the Attribute. The Attribute value is displayed in the position previously occupied by the Attribute tag. You can extract Attribute information from the drawing with the Drawing Editor's ATTEXT command. This command writes the Attribute information to a disk file in a form suitable for processing by user-supplied programs or for transfer to a database package such as dBASE IV.
Attributes can also be invisible. An invisible Attribute is not displayed or plotted; however, information about it is stored in the drawing file and written to the extract file by ATTEXT.

Example: Module Symbol Creation

To maintain a separate layer for the insertion of module symbols, the creation process can follow the following steps:

1. Open a new AutoCAD drawing file.
2. Create a symbol to be the defining block on LAYER 0.
3. Attach the appropriate attributes using the ATTDEF command.
4. Define the symbol with its associated attributes as a block using BLOCK command. The block name must match the one specified in the menu definition file.
5. Store the block just defined as an AutoCAD drawing file using WBLOCK command. The file name must match the one specified in the menu definition file.
6. Copy the final drawing file into the EWS working directory.

NOTE: The Convert program need to be modified accordingly whenever new blocks are created or blocks’ names are changed.
A.2. AutoCAD External Commands

In order to run another program from within AutoCAD, you must first inform AutoCAD of the name of the program, how much system memory (RAM) it requires, and various other details. You must supply this information in the "program parameters" file, "acad.pgp"; this file must be present when you begin executing AutoCAD.

"acad.pgp" is an ASCII text file wherein each line describes a program (or batch file) that can be executed from within AutoCAD. You can consider this to be a list of custom AutoCAD commands; any time you enter a command, AutoCAD looks for it in "acad.pgp" if it isn't a normal AutoCAD command.

Each line in "acad.pgp" has five fields, delimited by commas. The fields are:

1. **Command name**: The AutoCAD external command to be added. Must not be an internal AutoCAD command or it will be ignored. This name is case-insensitive.

2. **File Command**: This constant string will be sent to the operating system for execution when the command name is entered. It may be any valid command which you might execute when at your operating system's command prompt.

3. **Memory reserve**: On MS-DOS/PC-DOS systems, AutoCAD normally reserves all of the computer's memory (RAM) for itself. Before a program may be executed, AutoCAD must release sufficient memory to load the program. This required parameter specifies the number of bytes AutoCAD must release before executing the command. The number must be at least 4K larger than your program itself, to leave room for some data DOS needs in order to run your program. The minimum reserve is about 24K bytes, however. If the specified amount is less than this, AutoCAD forces it to 24K.

4. **Prompt**: This field, if supplied, specifies a prompt to be displayed to the user. If no prompt is specified, on input will be requested. If no prompt is desired and fields follow, just use two commas for the prompt field.

5. **Return code**: This is an optional bit-coded integer parameter. Its bits are defined as follows:
   - (i) 1 - Load DXB file
   - (ii) 2 - Construct block from DXB file
   - (iii) 4 - Restore text/graphics mode.

For more details, refer to AutoCAD Reference Manual. The "acad.pgp" of the EWS is shown in Appendix B.
APPENDIX B  ACAD.PGP File
CLS,CLS,100000,,4
CONVERT,\SEMATECH\EXE\CONVERT,275000,,0
DISP,\SEMATECH\EXE\DISP,460000,,0
DXF1,\SEMATECH\EXE\DXF1,140000,,0
FMTRX,\SEMATECH\EXE\FMTRX,300000,,4
FRAME,\SEMATECH\EXE\FRAME,300000,,4
HEURLP,\SEMATECH\EXE\HEURLP /N /P,400000,,4
MINISET,\SEMATECH\EXE\MINISET,150000,,0
MOD,\SEMATECH\EXE\MOD,250000,,0
MODULE,\SEMATECH\EXE\MODULE,250000,,4
PE,PE TECH.MNU,150000,,4
PROF1,\SEMATECH\EXE\PROF1,200000,,4
RCV,\SEMATECH\EXE\RCV,200000,,0
SEGMLIST,\SEMATECH\EXE\SEGLST,200000,,4
SHEET,\SEMATECH\EXE\SHEET,250000,,0
SHELL,,400000,*DOS Command: ,0
SIMUCPT,\SEMATECH\EXE\SIMUCPT,150000,,0
UPDATE,\SEMATECH\EXE\UPDATE,300000,,0
VEHICLES,\SEMATECH\EXE\VEHICLES,400000,,4
APPENDIX C  Brief Description of the EWS Files and Programs
The files copied into working directory and subdirectory EXE are required as support for the EWS. The following are the descriptions of selected EWS-specific files:

C.1. Files in working directory

ACAD.LSP - file contains user defined subroutines which can be called from within AutoCAD™ in the same manner as are internal AutoLISP functions. External subroutines are defined using the AutoLISP command, "defun". For more information, see AutoLISP Programmer's Reference Guide.

ACAD.PGP - is the file which specifies the external commands called from within AutoCAD™. These external commands can be either DOS commands, batch files, or executable programs. The format of the ACAD.PGP file is described in Appendix of the AutoCAD™ Reference Manual.

TECH.MNU - file contains the customized menu structure definition for the EWS.

CURVE1.DWG, CURVE2.DWG, STRAIGHT.DWG, TF1.DWG, TK1.DWG, TK2.DWG, TO1.DWG, TO2.DWG, TT1.DWG, TT2.DWG, and TV1.DWG - are drawing files which hold block definitions for elements such as curved or straight segments, horizontal transfers, stockers, turnouts, turntables, and vertical transfers respectively.

EFLAG, FLAG and FLAG$$$$ - are intermediate flag files which facilitate communication between external programs and the AutoCAD™ environment.

BASE.TXT - is a template file which specifies the information that will be extracted from the drawing file for conversion to the network representation. See the related command ATTEXT and the format of this file in Section 9.2.7.1 of the AutoCAD™ Reference Manual.

PROTOTYP.DWG - is the template (default) drawing file which contains the default drawing parameters and references to default block definitions.

QUIT.SCR - is a script file which is automatically run when a session ends. The user is returned to DOS without having to stop at the AutoCAD™ main menu. The primary reason for bypassing the main menu is to insure consistency between the drawing and project files.
SLIDES.LST - a file which contains a list of slide file names used to make slide library.

SLIDES.SLB - is a slide library containing the slides used for the EWS's icon menus.

START.BAT - is the batch file which performs several functions at the beginning of each session in the EWS. By default, START.BAT file comes initially configured for a single-screen system. For the dual-screen system, edit this file by removing "REM..." from the beginning of all commands. This file also displays an MHRC logo, configures AutoCAD™'s memory environment, prompts the user for the project which will be used during the editing session, activates AutoCAD™ in dual screen mode (when configured for dual-screen mode), and calls up the drawing file specified in the project profile.

C.2. Files in subdirectory EXE

CONVERT.EXE - program converts the geometric data extracted from the drawing file into its network representation. The output from this program consists of the segment data, the control point data, and the module data.

CBM.EXE - program sums the failure rate of several internal segments associated the modules to find the critical ones. These critical (i.e. high expected number of failures) modules are stored in an ASCII file named "TECH.CMP", and will be highlighted on the screen.

DISP.EXE - program generates graphic display of the system reliability measures for the user to quickly locate the "hot-spot" modules.

DXF1.EXE - program reads the DXF file generated from DXFOUT command of AutoCAD, and then output the file, SIMUCPT.DXF, with the control point ID's added.

FMTRX.EXE - program allows the user to specify the flow requirements between stockers. This program can also be called from DOS by typing

C:\SEMATECH >\SEMATECH\EXE\FMTRX

to display or update the flow information. Here we assume the working directory is SEMATECH.
FRAME.EXE - program performs the reliability assessment of the system.

HEUR1.EXE - program is the implementation of the preliminary flow path design algorithm by Bakkalbasi and McGinnis. The modeling assumptions are discussed in Chapter 1 of the EWS User's Manual.

MINISET.EXE - program simply copies file FLAG to FLAG$$$$. It is used to facilitate communication between the AutoCAD™ environment and the external programs.

MINPATH.EXE - program finds the shortest path between every pair of control points in the guidepath network, and computes the minimum travel distance between each pair of stockers. The shortest path matrix is stored in compact form as a .PTH file.

MOD.EXE - program takes the TXT and MIF file as input, then makes the changes to the TXT file necessary for representing all modules information.

MODULE.EXE - a utility program to access the module type information for the current session. It allows the user to scan, list, sort or print the module type information.

MSG.EXE - program simply displays the copyright information.

PROF1.EXE - program maintains the project profile for an EWS session. When called in START.BAT, it prompts the user for the active project name and sets the environment for the current session. This program can also be called from DOS by typing C:\SEMATECH >\SEMATECH\EXE\PROF1 to display or update the project profile.

RCA.EXE - program translates the critical segments found in the CSG file into the original (i.e. before modification) control points and their coordinates for subsequent AutoCAD display.

RESET.EXE - program simply copies the character $ into file FLAG$$$$$. It is used to reset the intermediate flag file.
SEGLST.EXE - is a utility program to access the segment information for the current session. The program will allow the user to scan, list, sort or print the segment information.

SHEET.EXE - program provide the user with a friendly way of entering module type date including IDs, MTBF, operation time etc., and remarks.

SIMUCPT.EXE - program copy a control-point-ID-added DXF file, SIMUCPT.DXF, to a DXF file which has the same name as currently-edited drawing file, and the extension DXF.

TITLE.EXE - program displays MHRC logo.

UPDATE.BAT - a batch file which updates the geometry-related information first, then computes the shortest paths.

VEHICLES.EXE - program allows the user to specify the vehicle type specifications. This program can also be called from DOS by typing $C:\SEMATECH >\SEMATECH\EXE\VEHICLES$ to display or update the vehicle specifications.
APPENDIX D  EWS Software Architecture and Structure

D.1 EWS Software Architecture
D.2 Software Internal Structure
D.1 EWS Software Architecture
D.2 Software Internal Structure